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BAB III 

METODE PENELITIAN 

 

Berikut ini adalah Alur penelitian yang di gunakan pada penelitian ini 

dengan digambarkan dalam bentuk Diagram Alur penelitian pada gambar 

3.1 

 

 

 

 

 

 

 

 

 

 

Gambar 3.1 Diagram Alur Penelitian 

1. Identifikasi Masalah 

Langkah awal yang sangat krusial dalam proses penelitian ialah mengenali 

permasalahan yang akan diselidiki. Langkah ini dapat dikerjakan dengan 

memeriksa masalah yang hendak diselidiki. Setelah itu, diambil langkah-

langkah untuk memahami lebih mendalam, baik dengan melakukan 

pengamatan maupun membaca literatur terkait. 

Gambar 3. 2 Diagram Alur Penelitian Gambar 3. 1 Diagram Alur Penelitian Gambar 3. 1 Diagram Alur Penelitian Gambar 3. 1 Diagram Alur Penelitian Gambar 3. 1 Diagram Alur Penelitian Gambar 3. 1 DIagram Alur Penelitian 
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2. Studi Literatur 

Dalam pendekatan ini, penulis melakukan pencarian bahan literatur untuk 

penulisan skripsi melalui berbagai pustaka dalam penelitian terkait, fokus 

pencarian adalah terkait dengan pembuatan rancang bangun alat komunikasi 

penyandang tunarungu dan tunawicara berbasis arduino nano. 

3. Perancangan Sistem 

Dalam penelitian ini, dilakukan perancangan sistem alat bantu komunikasi 

bagi penyandang tunarungu dan tunawicara yang dapat menerjemahkan 

gerakan tangan menjadi teks. Tahap perancangan sistem dilakukan dengan 

merumuskan konsep alat yang akan dibuat, yaitu sistem pengenalan huruf dan 

angka dalam bahasa isyarat (SIBI). Setelah konsep dirancang, proses 

dilanjutkan dengan implementasi sistem sesuai desain yang telah ditentukan. 

4. Pengujian Sistem 

Tahap pengujian sistem melibatkan serangkaian uji coba terhadap alat yang 

telah dibuat untuk memastikan bahwa sistem dapat berfungsi sebagaimana 

mestinya. Selain itu, pengujian ini bertujuan untuk mengidentifikasi serta 

menganalisis jika terdapat kesalahan atau ketidaksesuaian dalam kinerja 

sistem.. 

3.1 Analisa Kebutuhan Sistem (Hardware dan Software) 

3.1.1 Alat 

Sebelum memulai proses rancang bangun alat komunikasi penyandang 

tunawicara dan tunarungu berbasis arduino nano. Berikut alat yang akan 

dipersiapkan dapat dilihat pada Tabel 3.1 dibawah ini. 
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Tabel 3. 1 Alat yang dibutuhkan 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

3.1.2 Bahan 

Sebelum memulai proses rancang bangun alat komunikasi penyandang  

tunawicara dan tunarungu berbasis arduino nano. Berikut bahan yang 

akan dipersiapkan dapat dilihat pada Tabel 3.2 dibawah ini. 

 

No Nama Alat Spesifikasi Fungsi Jumlah 

1. 
Laptop 

 

4GB 
RAM/500GB 

ROM 

Sebagai 

Perancangan Dan 

Pemrograman 

Sistem  

1 Buah 
 

2. 
Obeng- Obeng 

Set 

 

Obeng Obeng 
Set 

 

Sebagai Membuka 

Atau 

Mengencangkan 

Baut Pada Kompen  

1 Buah 

 

3. 
Solder 

 
30 Wat 

 

Sebagai 

Penyambung Atau 

Melengkapi Antara 

Timah Dan 

Komponen  

1 Buah 
 

4. Arduino Ide 
Arduiuno 

2.03 
 

Sebagai Proses 

Uplod Kode 

Program Ke Alat 

Yang Dibuat 

1 Buah 
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Tabel 3. 2 Bahan yang dibutuhkan 

No Nama Bahan Spesifikasi Fungsi Jumlah 

1 
Arduiuno 

Nano 
 

Arduiuno 

Nano V3 
 

Sebagai pusat 
kendali sistem  
untuk membaca 

input dari sensor 
flex dan 

menghasilkan 
output ke LCD  

1 Buah 

 

2 Sensor Flex 2.2 Inch 

untuk mendeteksi 

pergerakan atau 

kelengkungan. 

2 Buah 

3 Lcd Display 16x2 

Menampilkan hasil 

interpretasi gerakan 

tangan dalam 

bentuk teks 

1 Buah 

4 PCB Bolong 

Pcb lubang 

ic dan 
transistor 

sebagai pengganti 

kabel dalam 

menghubungkan 

berbagai 

komponen, 

sehingga lebih 

hemat ruang dan 

efisien. 

1 Buah 

4 kabel jumper - 

Menghubungkan 

berbagai komponen 

di breadboard dan 

mikrokontroler  

11 Buah 

5. Resistor - 

Digunakan untuk 

pembagi tegangan 

dalam rangkaian 

sensor flex 

2 Buah 
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5 
Sarung 
Tangan  

- 

Sebagai media 

meletakkan sensor 

flex 

1 Buah 

6 
Sumber Daya 

(Power 
Supply) 

- 

Menyediakan 

sumber daya 

portabel bagi 

Arduino dan modul 

saat tidak 

menggunakan 

USB. 

1 Buah 

3.1.3 Software 

Sebelum masuk ke dalam perangkaian perangkat keras ada beberapa hal 

yang dibutuhkan dari system “ Rancang Bangun Alat Komunikasi 

Penyandang Tunawicara dan Tunarungu Berbasis Arduino Nano” ada 

beberapa software yang harus di install. Daftar software yang 

digunakan dalam penelitian ini terlampir pada table 3.3 

Tabel 3. 3 Software yang dibutuhkan 

No Nama Software Spesifikasi Fungsi 

1 Arduino IDE Arduino 2.3.6 Membuat program 
yang akan di upload 

ke perangkat 
Arduino 

2 Tinkercard 

 

Arduino nano Membuat rangkaian 
pada alat yang akan 

di buat 

 

3.2 Perancangan Sistem 

Pada Perancangan Alat Komunikasi Penyandang Tunawicara dan Tunarungu 

Berbasis Arduino Nano, menggunakan perangkat Arduino Nano, dijelaskan 

dengan lebih rinci pada diagram blok yang tertera dalam Gambar 3.2 di 

bawah ini 
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Gambar 3. 2 Diagram Blok Sistem 

Dari gambar diatas Menunjukkan proses kerja sistem, di mana sensor 

flex bersama resistor berperan sebagai input untuk mendeteksi 

perubahan lekukan jari yang membentuk bahasa isyarat. Data hasil 

pembacaan tersebut dikirim ke Arduino Nano untuk diproses. Setelah 

pemrosesan selesai, hasilnya diteruskan ke LCD sebagai output. 

3.2.1 Perancangan Perangkat Keras 

Pembuatan instrumen membutuhkan perencanaan yang matang, 

termasuk pemilihan komponen yang sesuai. secara akurat akan 

mengurangi pembelian komponen dan alat yang tidak perlu. Memahami 

karakteristik 

3.2.1.1 Rangkaian  Sensor Flex  

Sensor flex digunakan untuk alat komunikasi penyandang 

tunawicara dan tunarungu berbasis arduino nano,untuk cara 

pemasangan sensor flex dan resistor dapat dilihat pada gambar 3.3 
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Gambar 3. 3 Rangkaian Sensor Flex 

Keterangan dan Nama alat dalam Rangkaian : 

1. Sensor Flex 2.2 

Digunakan untuk mendeteksi perubahan lengkungan atau 

tekukan jari dan menghasilkan perubahan resistansi sebagai 

sinyal input. 

2. Kabel Jumper 

Berfungsi menghubungkan komponen satu dengan yang lain 

agar arus listrik dan data dapat mengalir sesuai rangkaian. 

3. Resistor 10k. 

Berperan sebagai pembatas arus sekaligus pembentuk pembagi 

tegangan untuk membantu pembacaan sinyal dari sensor. 

4. Breadboard 
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Papan perakitan sementara yang memungkinkan penyusunan 

dan pengujian rangkaian tanpa penyolderan, sehingga 

mempermudah perancangan. 

5. Arduino Nano V3 

Mikrokontroler yang memproses data dari sensor dan 

mengontrol keluaran sistem sesuai program yang diunggah. 

Pada rangkaian sensor flex menguunakan  pin pada Arduino Nano 

yaitu dapat dilihat pada  tabel 3.4 dibawah ini . 

 

 

    

 

 

 

 

 

 

Tabel 3. 4 Pin Sensor Flex 

3.2.1.2 Rangkaian Lcd  

Sirkuit LCD I2C dalam perancangan ini berfungsi sebagai tampilan 

hasil input dari sensor flex. Informasi yang ditampilkan bertujuan 

untuk memudahkan komunikasi pengguna, terutama bagi 

penyandang tunawicara dan tunarungu dapat dilihat pada gambar 

3.4 

 

No 
Sensor Flex dan 

resistor  
Arduino Nano 

1 
Sensor Flex 1 
Resistor 

A1 

2 
Sensor Flex 2 
Resistor  

A2 

4 GND Bersama GND 
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Gambar 3. 4 Rangkaian Lcd 16x2 

 Keterangan dan Nama alat dalam Rangkaian : 

1. Arduino Nano V3 

Sebagai mikrokontroler yang menangani pemrosesan data dari 

input dan mengontrol keluaran ke perangkat lain. 

2. Lcd 16x2 i2C 

Digunakan untuk menampilkan hasil keluaran berupa teks dua 

baris dengan komunikasi I2C sehingga penggunaan pin lebih 

efisien. 

3. Breadboard 

Papan perakitan sementara yang memungkinkan penyusunan 

rangkaian tanpa perlu penyolderan, sehingga mempermudah 

pengaturan dan pengujian rangkaian. 
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4. Kabel Jumper 

Berfungsi sebagai penghubung antara komponen di breadboard 

dan Arduino agar arus listrik serta sinyal data dapat mengalir 

dengan baik. 

 

Modul LCD 16x2 yang menggunakan antarmuka I2C memiliki empat 

pin koneksi. Rancangan koneksi antara modul LCD tersebut dengan 

Arduino Nano dapat dilihat pada tabel 3.5 

 

 

 

 

 

 

 

 

Tabel 3. 5 Pin Lcd 

3.2.1.3 Rangkaian Keseluruhan 

Dalam Skema rancangan keseluruhan ini, tujuannya adalah untuk 

memeriksa apakah sensor yang digunakan mampu beroperasi 

dengan efektif sesuai dengan prinsip kerja yang diinginkan. 

Contohnya, Sensor flex yang digunakan berperan dalam 

mendeteksi perubahan posisi atau kelenturan jari pengguna. Ketika 

jari mengalami tekukan, resistansi pada sensor tersebut meningkat, 

yang kemudian menyebabkan perubahan tegangan yang terdeteksi 

oleh pin analog pada Arduino Nano dapat dilihat pada gambar 3.5  

 

NO LCD Arduino Nano 

1 Vcc 5v 

2 GND GND 

3 SDA A4 

4 SCL A5 
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Gambar 3. 5 Rangkaian Keseluruhan 

Keterangan dan Nama alat dalam Rangkaian : 

1. Sensor Flex 2.2 

Digunakan untuk mendeteksi perubahan kelenturan atau 

tekukan jari yang nantinya menjadi masukan (input) bagi 

sistem. 
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2. Resistor 10k 

Berperan sebagai komponen pembagi tegangan agar 

perubahan nilai resistansi dari sensor dapat dibaca oleh 

Arduino. 

3. Kabel Jumper 

Digunakan untuk menghubungkan komponen satu dengan lainnya 

di atas breadboard agar rangkaian dapat bekerja. 

4. Arduino Nano V3 

Bertindak sebagai pusat pengolah data, menerima sinyal dari 

sensor flex, memprosesnya, kemudian mengirim hasilnya ke 

LCD. 

5. Lcd 16x2 i2C 

Menampilkan data hasil pengolahan dalam bentuk teks agar 

dapat dibaca dengan mudah. 

6. Breadboard 

Menjadi media perakitan komponen elektronik tanpa perlu 

penyolderan, memudahkan pengaturan dan pengujian 

rangkaian 

Pada rangkaian keseluruhan ini agar berjalan dengan lancer tentunya 

kita harus memastikan bahwasannya upload data dari Arduino IDE ke 

Mikrokontrorel harus berjalan dengan lancar. Berikut proses upload 

data dari Arduino IDE ke Arduino Nano pada gambar 3.6 dibawah ini 
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Gambar 3. 6 proses Upload Data dari Arduiono IDE ke Arduino nano 

Berikut adalah Penjelaskan Bagian-bagian Ide Arduino dan kode Sesuai 

Gambar di atas : 

  Bagian-bagian Ide Arduino dan Penjelas : 

1. Verity : Tombol ini digunakan untuk memeriksa atau mengompilasi 

sketch yang telah dibuat sebelum diunggah ke papan Arduino. Saat 

proses Verify dijalankan, setiap kesalahan yang terdapat dalam sketch 

akan ditampilkan dalam bentuk pesan error. Kesalahan tersebut bisa 

berupa kesalahan sintaks, logika kode, maupun penulisan. Apabila 

sketch sudah bebas dari kesalahan, maka program tersebut akan 

diterjemahkan menjadi kode biner yang selanjutnya siap diunggah ke 

mikrokontroler pada papan Arduino. Proses Verify/Compile juga dapat 
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dilakukan melalui menu Sketch → Verify/Compile atau dengan 

menekan pintasan keyboard Ctrl + R. 

2. Upload : Tekan tombol “Upload” pada perangkat lunak Arduino. 

Tunggu beberapa saat sambil memperhatikan LED TX dan RX di papan 

yang akan berkedip. Jika proses unggah berhasil, akan muncul pesan 

“Done uploading.” di bilah status. Sesaat setelah proses unggah selesai, 

LED bawaan pada pinndi papan Arduino akan mulai berkedip 

(berwarna oranye). Jika LED berkedip sebagaimana mestinya, berarti 

Arduino dan program telah berjalan dengan sukses 

3. Nama Sketch : Panel ini menampilkan nama file dari sketch yang 

sedang dikerjakan. Jika file belum disimpan, sistem akan otomatis 

memberikan nama default dengan format sketch_xxx, di mana xxx 

menunjukkan tanggal pembuatan sketch. File tersebut memiliki ekstensi 

.ino. Kita dapat menyimpannya dengan nama yang mudah diingat atau 

sesuai dengan fungsi maupun aplikasi yang sedang dibuat. 

4. Sektch Editior : Sketch editor merupakan area tempat kita menuliskan 

program atau sketch Arduino menggunakan bahasa C. 

5. Serial Monitor : Tombol ini berfungsi untuk membuka antarmuka 

komunikasi serial antara komputer atau laptop dengan papan Arduino. 

Serial Monitor digunakan sebagai alat bantu untuk men-debug sketch 

secara perangkat lunak. Fitur ini juga dapat diakses melalui menu Tools 

→ Serial Monitor atau dengan pintasan keyboard Ctrl + Shift + M. 

6. Serial Port : Menu Tools > Serial Port pada Arduino digunakan untuk 

memilih port yang sesuai. Umumnya dipilih COM3 atau di atasnya, 

karena COM1 dan COM2 sudah dipakai untuk port serial bawaan 

perangkat keras. Untuk memastikan port yang benar, lepaskan terlebih 

dahulu koneksi Arduino, kemudian buka kembali menu tersebut; port 

yang hilang adalah milik board Arduino. Sambungkan kembali board 

dan pilih port yang muncul sesuai dengan perangkat tersebut. 

7. Konsol : Panel konsol ini menampilkan pesan kesalahan yang terjadi 

selama proses kompilasi maupun pengunggahan. Baris yang bermasalah 
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akan ditandai dengan warna merah pada sketch, sehingga memudahkan 

kita untuk memeriksa dan memperbaikinya. Selain itu, panel ini juga 

memberikan peringatan apabila papan Arduino tidak terdeteksi oleh 

aplikasi. 

8. Tools : pada menu Tools > Board, pilih jenis papan Arduino yang sesuai 

dengan perangkat yang digunakan. 

3.3 Perancangan Perangkat Lunak 

Perancangan perangkat lunak adalah proses perencanaan dan 

pengorganisasian struktur,komponen ,modul,dan interaksi di dalam 

perangkat lunak yang akan dibangun.ini adalah langkah yang sangat penting 

dalam siklus pengembangan perangkat lunak, di mana konsep dan 

persyaratan dari tahap analisis dipecah menjadi rencana teknis yang akan 

digunakan untuk mengimplementasikan solusi perangkat lunak 

 

3.3.1 Flowchart Sistem secara Keseluruhan 

Penjelaskan pada Flowchart alur kerja sistem dalam membaca dan 

memproses data dari dua sensor flex yang berfungsi mendeteksi gerakan 

jari. Proses dimulai dengan mengaktifkan atau menginisialisasi sensor flex 

dan modul LCD sebagai tahap persiapan sistem. Setelah proses inisialisasi, 

sistem akan secara berulang membaca data dari kedua sensor. 

Kemudian, sistem mengevaluasi nilai yang terbaca dari sensor 1. Jika nilai 

tersebut berada di bawah 216, maka sistem akan menampilkan A1"216" 

dan huruf “A” pada layar LCD. jika nilai 

sensor 1 melebihi 176 dan tidak memenuhi kondisi sebelumnya, maka 

tampilan LCD akan menunjukkan A1"176" dan H “B”.Jika tidak ada 

kondisi yang sesuai dari sensor 1, sistem akan melanjutkan pemeriksaan 

terhadap nilai dari sensor 2. Apabila nilai sensor 2 lebih kecil dari 87, 

maka A "87" dan H “C” akan ditampilkan pada LCD. Sedangkan jika nilai 

sensor 2 lebih besar dari 161, sistem juga akan menampilkan A"161", 

tetapi dengan H1 “C".Secara keseluruhan, flowchart ini menunjukkan 
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bagaimana sistem memproses input dari sensor flex berdasarkan ambang 

nilai tertentu, lalu menampilkan karakter dan nilai yang sesuai pada LCD 

sebagai bentuk interpretasi dari gerakan jari yang terdeteksi pada gambar 

3.7 dibawah ini 

 

        

Gambar 3. 7 Flowchart Sistem secara Keseluruhan 
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3.3.2 Perangkat Lunak Arduino IDE 

Untuk dapat mengoperasikan perangkat lunak Arduino IDE, 

Anda perlu melakukan proses instalasi terlebih dahulu. Berikut 

adalah langkah-langkah untuk menginstal nya: 

1. Persetujuan Instalasi Aplikasi Arduino IDE  

Buka file instalasi Arduino IDE dengan mengklik dua kali. Setelah 

itu, akan muncul perjanjian instalasi atau License seperti yang 

ditampilkan dalam gambar dibawah ini. Klik tombol "I Agree" 

untuk memulai proses pemasangan. Untuk gambar persetujuan 

instalasi software Arduino IDE bisa dilihat pada gambar 3.8. 

        

Gambar 3. 8 Persetujuan Instalasi Aplikasi Arduino IDE 
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2. Pemilihan Opsi Instalasi  

Selanjutnya ke opsi instalasi, klik centang pada semuanya untuk pemilihan 

opsi bisa dilihat pada gambar 3.9 

 

Gambar 3. 9 Pemilihan Opsi Instalasi 

3. Proses Ekstrak dan Instalasi  

Pada tahap ini menunggu proses instalasi selesai untuk proses ekstrak instalasi 

bisa dilihat pada gambar 3.10 
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Gambar 3. 10 Proses Ekstrak dan Instalasi 

4. Halaman Tampilan Pada Arduino IDE  

Setelah proses instalasi selesai maka tampilan halaman pada Arduino IDE 

pada aplikasi bisa dilihat pada gambar 3.11 

 

Gambar 3. 11 Halaman Tampilan Pada Arduino IDE 
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3.3.3 Software EasyEDA 

 1. Proses Pembuatan Rangkaian Elektronik biasa menggunakan Sofware 

EasyEDA karna mendukung berbagai Fitur Seperti 2D dan 3D.  

2. Eksport File yang sudah dirancang dari EasyEDA ke dalam bentuk 

format Gerber/PDF.Rancangan dapat dilihat pada gambar 3.12 

 

 

Gambar 3. 12 Platform EasyEDA 

3.4 Rencana Pengujian Sistem  

Setelah tahapan perancangan perangkat keras dan perangkat lunak 

selesai, program dieksekusi dan setiap komponen diuji untuk 

memastikan sesuai atau tidak dengan yang diinginkan. Pengujian 

dilaksanakan pada sensor-sensor dan seluruh sistem rangkaian ini. 
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3.4.1 Pengujian Sensor Flex  

Cara Melakukan Pengujian  Sensor Flex  

1.   Pasang sensor flex pada jari sarung tangan sesuai rancangan, 

kemudian hubungkan ke pin analog Arduino Nano. 

2.   Nyalakan rangkaian dan buka Serial Monitor pada Arduino 

IDE. 

3.   Luruskan jari yang terpasang sensor, lalu perhatikan dan catat 

nilai yang ditampilkan. 

4.  Tekuk jari hingga posisi maksimal, amati dan catat kembali 

nilai pembacaannya. 

5.   Ulangi gerakan lurus dan tekuk beberapa kali untuk 

memastikan data yang terbaca stabil serta dapat dibedakan 

dengan jelas. 

6.   Bandingkan nilai hasil pembacaan dengan ambang batas yang 

diprogram untuk memastikan Arduino mengenali posisi jari 

lurus maupun tekuk secara benar. 

 

3.4.2 Pengujian  LCD 

Cara Melakukan Pengujian Lcd : 

1.  Sambungkan modul LCD I2C 16x2 ke Arduino Nano melalui pin 

SDA dan SCL. 

2. Jalankan program sederhana untuk mengirimkan teks percobaan 

(angka dan huruf) ke LCD. 

3.   Periksa tampilan LCD, pastikan karakter muncul sesuai dengan 

yang dikirim. 

4. Lakukan pengiriman teks yang berbeda secara berulang guna 

memastikan komunikasi I2C berjalan lancar tanpa error. 

5. Pastikan backlight LCD aktif agar tampilan jelas dan mudah dibaca 

 

 



 
 

44 
 

3.4.3 Pengujian Keseluruhan Sistem 

Cara Melakukan Pengujian Keseluruhan Sistem : 

1. Pengujian Sensor Flex (2 Jari) 

  Pasang sarung tangan dengan dua sensor flex sesuai rancangan. 

 Gerakkan jari ke posisi lurus dan tekuk sesuai pola. 

    Amati nilai analog yang diterima Arduino, pastikan tiap gerakan 

menghasilkan data yang berbeda sesuai kondisi jari. 

2.   Pemrosesan Data oleh Arduino Nano 

 Gunakan sketch yang telah diprogram untuk mengenali pola   

gerakan jari. 

 Lakukan beberapa kombinasi gerakan jari untuk memeriksa apakah 

pola tersebut dikenali sesuai dengan kode angka dan huruf  yang 

diatur. 

3.  Menampilkan Hasil di LCD I2C 16x2 

 Amati keluaran di LCD setelah gerakan dilakukan. 

 Pastikan angka dan huruf yang tampil sesuai dengan pola gerakan 

jari yang dimaksud. 

4.   Evaluasi Keluaran 

 Cocokkan hasil tampilan dengan gerakan jari yang dilakukan. 

 Jika sesuai, sistem dinyatakan bekerja dengan baik. Jika tidak, 

lakukan pengecekan ulang pada logika program atau sambungan 

sensor untuk menemukan dan memperbaiki masalah. 

 

 

 

 


